Excel 2019 Worksheets

Switching between worksheets

* Open a workbook called Worksheets.
» The worksheet tabs are displayed at the bottom-left of the Excel
screen.
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* To switch to another worksheet, click on the worksheet tabs.

Renaming a worksheet

» Click on the Sheetl tab to display the first worksheet. Double click on
the Sheetl tab.
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+ The worksheet tab will be highlighted and you will be able to type in a
new name.
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* In this case type in the name 2011 and then press the Enter key to
confirm the change, as illustrated.
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* Double click on the Sheet2 tab and rename it 2012.
* Double click on the Sheet3 tab and rename it 2013. Your tabs will
now look like this:
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Recommended techniques with naming worksheets

O By default, the worksheets are called Sheetl, Sheet2 and Sheet3. You
should use meaningful names for your worksheets, especially if you
are using multiple worksheets within a workbook. This can make a
complicated workbook much easier to understand.

Inserting a new worksheet

+ Click on the 2013 worksheet tab to select it. Right click over the tab
and from the popup menu displayed, click on the Insert command.
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* The Insert dialog is displayed. Make sure that the Worksheet object
is selected within the dialog box.
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* Click on the OK button and a new worksheet will be inserted just
before the selected worksheet, as illustrated.
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Deleting a worksheet

O Make sure that the new tab that you have just inserted is selected.
Right click on the tab and from the popup menu displayed select the
Delete command. The new worksheet will be deleted.
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Copying a worksheet within a workbook

+ Select the 2011 tab. Right click on the tab and from the popup menu
displayed select the Move or Copy command.
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* The Move or Copy dialog box is displayed. As we want to copy rather
than move, click on the Create a copy check box. In the Before



sheet section of the dialog box, select which worksheet you wish to
insert the copy in front of. In this case select 2013.
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*  When you click on the OK button a copy of the first worksheet will be
inserted, as illustrated.
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» Delete this copied worksheet before continuing.

Moving a worksheet within a workbook

+ Select the 2011 tab. Right click on the tab and from the popup menu
displayed select the Move or Copy command.
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+ The Move or Copy dialog box is displayed. In the Before sheet
section of the dialog box, select which worksheet you wish to insert the
moved worksheet in front of. In this case select 2013.
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* When you click on the OK button the worksheet will be moved, as
illustrated below.
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» Before continuing, rearrange the worksheets in the original order.
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* Save your changes and close the workbook.

Copying or moving worksheets between workbooks

* Open a workbook called Between workbooks 2. Leave this
workbook open.

* Open a workbook called Between workbooks 1.

* Within the workbook called Between workbooks 1 click on the
worksheet tab for This Year’s Sales.

* Right click on the This Year’s Sales tab and from the popup menu
displayed select the Move or Copy command.
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+ The Move or Copy dialog box is displayed.
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* Click on the down arrow in the To book section of the dialog box.
From the drop down list, select the workbook called Between
workbooks 2, as illustrated below.
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Use the Before sheet section of the dialog box to determine where in
the second workbook the worksheet will be copied to.

Click on the Create a copy check box.

J

Create a copy

Click on the OK button.

Switch to the second workbook and you should see a copy of the
worksheet inserted into the workbook.

TIP: Experiment with moving a worksheet between workbooks using
the same method, but this time do not click on the Create a copy
check box.

[C] create a copy

When you have finished experimenting save the changes in both your
workbooks and close all open files.



Alignment formatting within Excel

Alignment options

0 The alignment options are contained within the Alignment group on the
Home tab.
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Horizontally aligning contents in a cell range

* Open a workbook called Alignment.

+ Select the range C3:G12.

* Click on the Center icon to centre the cell contents in this range. Try
applying left and then right alignment formatting. Use the alignment
icons illustrated below.
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Centring a title over a cell range

* Click on cell C2 and type in the word 'Sales’.
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38 Country 2009 2010 2011 2012 2013
4 India 102 129 189 193 201
5 Canada 98 120 121 132 143
6 USA 109 110 109 102 94
7 United Kingdom 92 99 98 95 85
8 | Australia 92 95 96 92 93
g New Zealand 32 43 54 74 84
10 China 67 79 83 88 93
11| Pakistan 24 34 43 54 73
12 Mexico 12 24 20 23 32

+ We want to centre this within the range C2:G2. To do this, select the

range C2:G2.
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3 Country 2008 2010 2011 2012 2013
4 India 102 129 189 193 201
5 Canada 98 120 121 132 143

* Click on the Merge and Center icon.
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* Your screen will now look like this.
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33 Country 2009 2010 2011 2012 2013
4 India 102 129 189 193 201
& Canada 98 120 121 132 143
6 USA 109 110 109 102 94
7 United Kingdom 92 99 98 95 85
8 | Australia 92 95 96 92 93
9 | New Zealand 32 43 54 74 84
10 China 67 79 83 88 93
1 Pakistan 24 34 43 54 73
12 | Mexico 12 24 20 23 32
Cell orientation
+ Select the range C3:G3.
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4 India 102 129 189 193 201
5 Canada 98 120 121 132 143
* Click on the Orientation icon.
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You will see a drop down menu allowing you to format the cell

orientation.
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+ Select the Angle Clockwise command. Your data will now look like
this.

A B C D E F G

1

2 \ Sales

3 Country e% t’90 \"Q\) ‘JQ\-’ ego’
4 | India 102 129 189 193 201
5 | Canada 98 120 121 132 143
6| USA 109 110 109 102 94
7 United Kingdom 92 99 98 95 85
8 | Australia 92 95 96 92 93
9 | New Zealand 32 43 54 74 84
10 | China 67 79 83 88 93
1| Pakistan 24 34 43 54 73
12| Mexico 12 24 20 23 32

» Experiment with applying some of the other orientation effects.

Text wrapping within a cell

* Click on cell B14. Type the following text into cell B14.

All revenues are pre-tax profits.

* When you press the Enter key you will see that the text does not 'fit'

into the cell.

A B C D E F G
1 4
2| Sales
3| Country e%& t’90 ‘JQ\’ 999 99\?
4| India 102 129 189 193 201
5| Canada 98 120 121 132 143
6 | USA 109 110 109 102 94
rdl| United Kingdom 92 99 98 95 85
8 | Australia 92 95 96 92 93
9 | New Zealand 32 43 54 74 84
10 China 67 79 83 88 93
1 Pakistan 24 34 43 54 73
12| Mexico 12 24 20 23 32

13

14 | All revenues are_l pre-tax profits
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» Select cell B14 and click on the Wrap Text button.
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* The cell will now look like this.
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: Sales
3 Country r’% er t’g,\’ eee’ ?’Q&
4 India 102 129 189 193 201
5 | Canada 98 120 121 132 143
6 | USA 109 110 109 102 94
7 United Kingdom 92 99 98 95 85
8 Australia 92 95 96 92 93
9 | New Zealand 32 43 54 74 84
10 | China 67 79 83 88 93
1| Pakistan 24 34 43 54 73
12 | Mexico 12 24 20 23 32
13|

All revenues are pre-

14 | tax profits
15 |

Save your changes and close the workbook.

Aligning cell contents vertically

Open a workbook called Vertical alignment. As you can see the cell
contents are aligned to the bottom of the cell.
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3 Sales Area 2010 2011 2012 2013
4 North 234 254 287 300
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Select the data area as illustrated.
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Sales Area 2010 2011 2012 2013
North ‘ 234 254 287 300
South ‘ 654 763 427 675
East ‘ 324 324 553 432
West 234 543 347 432

3

Click on the Home tab and from within the Alignment group select the
required vertical alignment option.
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Experiment with applying each of the three vertical alignment options.
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After you have finished experimenting, set the alignment to Middle
Alignment. O Save your changes and close the workbook.

Format Painter

Open a workbook called Format painter.

Click within the upper table.

Click on the Format Painter icon. This icon is contained within the
Clipboard group under the Home tab.
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Once you click on the Format Painter icon, you will notice that the
shape of the mouse pointer changes to the shape of a paintbrush.

You can now apply the formatting within the cell that you clicked on, to
another range within the worksheet.

Click on cell B14, and while keeping the mouse button pressed, move
the mouse pointer to cell G23. Release the mouse button and the
formatting will be copied to the second range within your worksheet, as
illustrated.
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Save your changes and close the workbook.
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Inserting lllustrations

How to insert a picture into a cell in Excel

Unlike with some other platforms, you simply can’t copy and paste a picture
into an Excel cell.

A | B C D . EF
1 =]
2 | Products
3 | T-Shirt Trousers Bag
4 .|
Products ® ] 3 -
To start, follow these steps:

e Make sure you'’re on the ‘Insert’ tab

Click the ‘Pictures’ button found on the ‘lllustrations’ group
Select the picture or pictures you would like to insert

File Home Insert Page Layout Formulas Data Review View Help
o=l =| T 71 E& Online Pictures (7] 3D Models ~ EE‘_ .
T Get Add-ins
123 l? = IC\I;I |E{}Shapes* T SmartArt
PivotTab mmended Table Pictures aky ":] My Add-i . E
PivotTables &) lcons a4 Screenshot ~ o MY ins
Tables ustrations Add-ins
B4 - Fe
Products
3 T-Shirt Trousers Bag
After resizing them to fit the cells, there’s one problem left:

Resizing the columns or rows where the images reside does not
affect them.
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To solve that, you have to lock the pictures into the cells.
How to lock an image into a cell
For the image to resize when you resize the columns or rows, you will have to
change its properties.
To do so, simply right-click on the image and select ‘Format Picture...’
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This will open a right-hand pane where you can change the format of the

picture.

Go into the ‘Size & Properties’ tab and tick ‘Move and size with
cells’ on the ‘Properties’.
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4 Properties

* Move and size with cells

Move but don't size with cells
Don't move or size with ©

| Print object

+| Locked i

Lock text
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